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Section 1 

 
Introduction 
The Ohio Department of Health, Bureau of Vital Statistics is pleased to provide you with this 
easy step guide for usage of the Electronic Death Registration System (EDRS).  
 
Funeral Directors and Coroner/Physicians/E-Physicians Online with EDRS 

 
When a funeral user creates a death record, said user will assign the record to the 
coroner/physician/e-physician.  Once the funeral user completes the assigned portion of the 
record for Personal Info Complete, the coroner/physician/e-physician will subsequently 
complete their assigned portion.  If the death record has been assigned to a coroner, the 
coroner will receive the death record electronically, input the medical information into EDRS, 
and certify the death record within EDRS at which point the funeral director can then review and 
then certify the certificate, which will mark it as Registered, and make it available for issuance by 
the Local Health Department.  This process is the same for Coroners who are also E-Physicians.  
Paper assigned Physicians do not have the capability to receive electronic death records within 
EDRS and thus the funeral user must either print a paper death certificate and deliver it to the 
physician for completion by hand or the funeral user can email or fax the physician a PDF 
created death certificate for signage.  Once the physician completes the death record, they can 
either mail, fax, or email the completed and signed certificate back to the funeral home. 
 
Please note that if the email or fax option is utilized by any of the above named entities, the 
death record must retain the format correspondent to EDRS printing and must not present 
differently in size and must not show other markings such as a fax number or an email indicator. 
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Section 2 

 
Getting Started with EDRS 
 
To get started you will need to open your browser and enter the URL:  https://vital.odh.ohio.gov  
in the address box. 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open your Internet Browser  

This guide will use Internet 

Explorer for the browser. 

Enter the URL in the  

Address box 

https://vital.odh.ohio.gov/


  
2/9/2017 

 

 

The Ohio Department of Health, Bureau of Vital Statistics 

EDRS guide for Funeral Directors 

last updated:  5/12/2016 

 Page 5 of 64 

Ohio Department of Health 

Bureau of Vital Statistics 

Electronic Death Record System – Funeral Director  

Enter your user id and password. Click Log In 
 

 
 
 
Click the button as prompted to continue 
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If prompted to install applications, user can either click the green Install button and follow the 
prompts or, if Citrix has already been downloaded, the user can hit Skip To Log On. 
 

 
 
 
Click on the application icon: IPHIS/EDRS 
 

 
 
 
 
 
 
  
 

IPHIS/EDRS 
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Click on the Permit Use option 
 

 
 
If user has more than one funeral home location, the ‘select location’ dropdown box will 
appear for user to choose applicable location role.  Once chosen, click OK. 
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This is the Main Menu action screen for IPHIS/EDRS 
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Note:  if at any point when logging in, the user receives a message stating: 
 

 
 
…the user will need to log-out of EDRS for 15 minutes and then re log-in to clear the error.  This 
message indicates that either a current session is open or that a previous session ended 
abnormally but is still open.  The 15 minute threshold is the parameter set for an automatic 
session end.   
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Navigating the Software 
 
Each screen is composed of tabs, paragraphs, and fields.  

 The tabs can be thought of as pages.  These pages can be as long as needed but usually 
just take up one screen for ease of use.   

 A tab usually contains information pertaining to one aspect of the Event.  
 The user can go quickly from one tab to another by clicking on a tab heading with a 

mouse click or by pressing Alt-#, where # is the tab number (1, 2, 3, …) to be accessed.   
 
Each tab is composed of one or more paragraphs.   

 These paragraphs have a title and are designed to pertain to some particular aspect of 
the Event. 

 You can skip from paragraph to paragraph by pressing Ctrl-P. 
 
Each paragraph is composed of one or more fields.   

 Available field types are  
o drop-down 
o edit 
o check box 
o date edit 
o memo 
o signature 

 The user moves from one field to another by 
o pressing the Tab key 
o automatic after entering data into the field with the appropriate type and 

number of characters 
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Review the main screen – menu bar & “drop down” options 
 

 
 
The FILE menu item “drop down” options 
 

 
 
The Search menu item “drop down” options 
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HOT KEYS 
Presented below is a summary of various “hot key” combinations that can make certain data 
entry functions more efficient for those operators wanting to avoid use of the mouse and mouse 
menu navigation techniques.  They include use of the Control key (Ctrl), the Alternate key (Alt) 
and the Shift key (Shift). 
 

 
CTRL-C 

 
COPY  - This key copies the contents of the field containing the text cursor to the 
Windows clipboard. The field contents are not altered 
 

 
CTRL-O 

 
OVERRIDE  - This key sets the edit override indicator for the field containing the 
text cursor. 
 

 
CTRL-P 

 
The data entry form is built from labeled boxes which are called PARAGRAPHS (in 
Windows terminology, they are called group boxes). Pressing Ctrl-P will move the 
text cursor from the present field to the first enterable field in the next 
paragraph. 
 

 
CTRL-Q 

 
QUERY  - This key sets the query indicator for the field containing the text cursor. 
 

 
CTRL-R 

 
RESET QUERY/OVERRIDE  - This key removes the query or override indicator. Note 
that a field can be either overridden or queried, but not both. 
 

 
CTRL-S 
 

 
This key SAVES the current Event. It is equivalent to the File | Save menu item. 
 

 
CTRL-V 

 
PASTE  - This key pastes the contents of the Windows clipboard into the field 
containing the text cursor. The new contents replace whatever was previously in 
the field. 
 

 
CTRL-X 

 
CUT  - This key clears the present field and copies its contents to the Windows 
clipboard. From the clipboard it can be pasted into another data entry field, or 
into another Windows application which supports the clipboard. 
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CTRL-Z 
 

 
This key CLEARS the contents of the field containing the text cursor. 
 

 
CTRL-DELETE 
 

 
If the text cursor is in a mask edit field (a field with slash or dash characters), the 
field will be cleared, or DELETED, when Ctrl-Delete is pressed. 
 

 
CTRL-TAB 
 

 
This key combination will select the next notebook page. When the last notebook 
page is displayed, this key combination will display the first page. 
 

 
SHIFT-CTRL-TAB 
 

 
This key combination will select the previous notebook 

 
 

 
ALT-A Through ALT-
Z 
 

 
Certain menu items have underscores under a letter in the item name. Pressing 
Alt plus that letter is equivalent to selecting the menu item. 
 

 
ALT-1 Through ALT-
9 
 

 
These keys select notebook pages, or tabs, 1-9, respectively. 

ALT-F4 
 

 
This key combination will close the current window. It is equivalent to clicking the 
close window [X]. 
 

 
 

T (date field) 
 

 
Entering the letter “T” in a date field will insert “Today’s” date.  The date can then 
be advanced by entering an “F”, for Forward or brought back in time by entering a 
“B” for Back.   
 

 
 

 
Left Mouse Click 
 

 
The left mouse button can be used to place the text cursor in a particular field by 
clicking when the mouse cursor is over the desired field. The left mouse can also 
select notebook pages by clicking on the tab for the desired page. 
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Right Mouse Click 
 

 
A menu of options for a field may be displayed by clicking the right mouse button 
when the mouse cursor is positioned over the field. 
 

 
 
Record Status & Explanations 

 

Pending Status 

A death event record is considered to be pending from the time the initial information is saved 
into the EDRS Database. The record will remain in pending status until the personal 
information is signed and medical information is certified for the death record and the owner 
changes the status to “Y” for “Complete.”   

If the funeral director or coroner/physician assigned to the case reset the flag to “N” on the 
“Complete” acknowledged field to allow for changes in the personal information portion of 
the record, the record will be assigned the pending status.  

Complete Status Defined 

A death event record is considered complete only in the following scenarios: 

1. On the electronic death certificate sent to coroner, the funeral director has 
completed the personal information and the coroner has completed the medical 
information and the certification box. 

 2. On a paper death certificate sent to the physician, the funeral director has selected 
the “Paper-Phy” type, completed the personal information and printed the death 
certificate. 

Record status 

indicator fields 

are found on the 

Decedent tab. 
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Filed Status Defined. 

A death certificate record is considered filed when the record has been reviewed and 
approved by the local registrar with date filed information entered into the EDRS record and 
a local file number assigned.  

Once a record is filed, the funeral director/coroner/physician assigned to the death record 
cannot update the record unless rejected by a state clerk and re-assigned pending or 
complete status.   

The local registrars assigned to the record and who are responsible for filing the death 
occurring in their jurisdiction shall file the death record. 

Registered Status Defined 

A death certificate for a Paper-Phy record is considered to be registered when the record in 
filed status is verified at Vital Statistics.  A death certificate for an Electronic (coroner 
designated) record is considered to be registered when the local health department files the 
record.  Once a record is registered, the funeral directors, coroner/physician and local 
registrar assigned to the death record cannot print or update the record. 

 

Void Status Defined 

There may be instances where a death record needs to be voided.  For example, the 
information for a death is entered twice.  The record cannot be deleted, because Ohio 
Department of Health/Vital Statistics will need to be able to account for the State File 
Number.  In this instance, the person finding the duplicate entry will be required to report the 
entry to Vital Statistics.  Only Vital Statistics staff with the proper authority will have the ability 
to change the status of a record to void.  

 

Complete to Filed 

After receiving the death certificate signed from the funeral director, the local registrar will 
enter additional information into EDRS.  This will include: 

 Date the registrar signed the death certificate, which will be applied by the system 
when the registrar electronically signs the death certificate 

 Name of the registrar 

 Name, PRDN and date for burial permit issuance if provisional death certificate was 
not requested. 

After this additional information has been saved, the status of the death event record will 
change from complete to filed for a Paper-Phy record, and from complete to registered for an 
Electronic (coroner designated) record at which point a local file number is assigned to the 
record. 
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Complete to Pending 

If the funeral director changes the personal information completion field from “Y” to “N” or 
the coroner/physician changes the certifications of medical information from “Y” to “N” the 
record status will be changed back to pending.  

Filed to Registered 

When a death certificate record has a status of filed, the record will available for the Vital 
Statistics staff.  For the “Paper-Phy” records, the medical information which is not in EDRS will 
be updated by Vital Statistics.  

If the Vital Statistics staff member verifies that all the information is correct and available in 
the EDRS system, the status of the record will change from filed to registered.   

If the Vital Statistics staff member determines the record is not acceptable, the record status 
will be maintained as filed until registrar responds with corrected information. 

Once the death certificate record is registered, an Affidavit for funeral home information can 
be completed or a Supplement for certifier information can be completed and registered at 
Vital Statistics.  
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Data Entry Tips 
 County selection in the Place of Death paragraph will determine the registrar 

assignment on the record.  This automatic assignment cannot be changed for the 
registrar filing the record, but can be changed for the sub-registrar approving the 
permit.  

 Trade Call – Can be used to input the embalming home service provider on the record. 
 A funeral director cannot input “Cause of Death” on a record in EDRS. This will be 

entered by Vital Statistics after receipt of the paper death certificate. 
 The age of a deceased is calculated in the background. The system will notify you of an 

error via a pop-up error message if it doesn’t match.   
 When entering the ‘Time of Death’ you can enter a range if the exact time is not known.  

For example, 12:23 time of death with a range of 11:32 to 13:09. 
 The burial permit can be printed by the registrar or the funeral director, and should be 

determined on a ‘case by case’ basis. 
 If a record is placed in Electronic (coroner designated) filing status, and is then 

determined to be a Paper-Phy record, the changing of the filing type will not update the 
record or assign an SFN-  the record will need voided via calling the Vital Statistics 
HelpDesk. 

 If a record is placed in Paper-Phy filing status, and is then determined to be an Electronic 
(coroner designated) record, the changing of the filing type can be updated by calling 
the Vital Statistics HelpDesk.  

 In the case of a social security number being unknown, not obtainable, or not 
applicable, it must be entered as all 9s.   

 In the case of a social security number status being returned as failed, as long as the 
funeral user has verified the info with the family, documentation, etc…the failed 
message does not impact the normal processing of the death record up to and including 
printing, saving and filing.    
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Error Message Pop-up 
The pop-up error message box appears when the system does not accept your data entry.  You 
can choose to “re-key the field”, “skip for now”, “override edit”, or “query field”. 

 When you select “re-key the field” the system will immediately place the cursor in the 
field requiring the correction. 

 When you select the “skip for now” the system will allow you to move past the error 
and correct it later.   

o The section on “Reviewing Errors” later in this document provides instructions 
on how to view the fields with errors that you have skipped during data entry. 

 When you select the “override edit” option, the system will let you save the record and 
the registrar will review the override for correctness.  Use this option when you are 
positive the data entry is correct. 

 Selecting “query field” will flag/highlight the entry and keep the data as entered. 
 

 
 
Pandemic Feature 
 
The new system features a Pandemic capability.  If this feature were to be needed, Vital 
Statistics will provide you with instructions and support for its use. 
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Section 3 

 
As you are entering the personal information for the deceased, you will need to make several 
selections/decisions regarding the record. 

 For Physician records, the Paper-Phys filing type must be selected.  For Coroner records, 
the Electronic filing type must be selected. 

 Selection of the certifier –Although all of the physicians are not actively using the 
system, his or her name must be selected from the drop down list in the certifier field.  
If a physician is not in the dropdown database, you must choose Other and type the 
certifier’s information in manually.  For license info and verification, please referenct 
https://license.ohio.gov/lookup/default.asp. 

 Determine if the deceased is a Veteran.  If they are a Veteran, you must input the 
information on the death record.  The information does NOT print on the certificate. 

https://license.ohio.gov/lookup/default.asp
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Steps for Creating a “PAPER-PHYSICIAN” Death Certificate 

 
Click File - New – Death 

 
 
Begin entering the decedent information ( First Name, Middle Name, Last Name, Date of 
Death, etc.)  
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Enter information for Decedent, Veteran (if necessary), Relative/Informant, Disposition, Trade 
Call (if necessary), Certifier, Completed tabs 
 
Note:  If the deceased is a Veteran you will need to enter a “Y” in the Armed Forces box.  This 
will trigger the Veteran tab to allow data entry.  The “N” indicates the tab is not needed on the 
record, and the fields remain grayed out.  
 
Enter “Y” on “N” in Ever in Armed Forces? 
 

 
 
 
 
Enter the Veteran information for the deceased, if necessary. 
 

 
 
 
 
 
 
 

If you enter “Y” the Veteran 

tab opens for data entry.  If 

you enter “N” the Veteran 

tab will remain grayed out. 
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Select the Certifier Name from the “drop down” list 
 

 
 
Note:  On both Physician (paper) and Coroner or E-Physician (electronic) records, the Paper or 
Electronic designation will automatically update based on the type of Certifier chosen.    
 
If the Physician name is not in the dropdown, funeral user will need to choose Other and type 
the information as required on the Certifier tab.  License info can be searched and verified at 
https://license.ohio.gov/lookup/default.asp 
 
On the Registrar tab, request either a burial or cremation permit.  If the Disposition is Removal 
From State, the transit permit will be requested via the Burial permit checkbox. 

 

https://license.ohio.gov/lookup/default.asp
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On the Completed tab, enter “Y” Personal Info Complete (all dates will autopopulate with Save 
action).  On the Completed tab, enter another “Y” in the certification statement (only a funeral 
director can enter this field)  
 

 
 
Click File – Save 
 

 
 

SSN Verification 

After you save the record, the system will notify you of the SSN checking process. 
Click “OK” to exit pop up window. 

 
 
To check the status of the online SSN verification you will need to: 

 close the record (after it has been saved) 
 reopen the record (using the SEARCH utility or the work queue to locate the record) 
 on the Decedent tab, check the Return Status field for SSN Verification 
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The maximum number of attempts for verification of a SSN is 5.  The SSN field will be locked 
once the verification is sent by SSA. 
 
Note:  The combination of completing and saving, and then certifying and saving, will change 
the status of the record from Pending to Complete.  The death certificate can now be printed. 
 
Note:  The status of the SSN record (Passed, Failed, etc…) does not impact the normal death 
record completion process.  If an SSN is in a failing status, but has been verified as a match with 
what the family provided, the death record process should continue up to and including being 
filed at the local health department. 
 
Note:  Once the social security number has passed, it will lock the fields of the decedent’s Name, 
Date of Birth, and Gender.   
 
 
Select Requests – Print: Death Certificate-Paper 
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Steps for Creating an “Coroner-Electronic” or “E-Physician” Death Certificate 

  
Click File - New - Death 

 
 
Enter Deceased Information (First Name, Middle Name, Last Name, Date of Death, etc.)  
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Enter “Y” on “N” in Ever in Armed Forces? 
 

 
 
Enter the Veteran information for the deceased, if necessary. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you enter “Y” the Veteran 

tab opens for data entry.  If 

you enter “N” the Veteran 

tab will remain grayed out. 
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Select the Certifier Type and Name from the “drop down” list 
 

 
 
Note:  On both Physician (paper) and Coroner or E-Physician (electronic) records, the Paper or 
Electronic designation will automatically update based on the type of Certifier chosen.    
 
On the Registrar tab, request either a burial or cremation permit.  If the Disposition is Removal 
From State, the transit permit will be requested via the Burial permit checkbox. 
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Enter “Y” for Personal Info Complete. 
 
Note:  it is a good practice for the funeral user to avoid entering the second “Y” for certification 
until the coroner or e-physician has certified the record, as once both the funeral director and 
coroner/e-physician certify the record, it is placed in the final Registered status and cannot be 
amended without an affidavit or supplement.  
 
 
 
Click File – Save 

 
 
 
 
 
At this point, the assigned coroner will be able to view and edit the record on the cause of 
death tab.  Once the coroner completes and certifies the record, the funeral home will be able 
to review it and then certify it, which will put the record in Registered status, and will then be 
available for issuance at the Local Health Department. 
 

SSN Verification 

After you save the record, the system will notify you of the SSN checking process. 
Click “OK” to exit pop up window. 

 
To check the status of the online SSN verification you will need to: 

 close the record (after it has been saved) 
 reopen the record (using the SEARCH utility or the work queue to locate the record) 
 on the Decedent tab, check the Return Status field for SSN Verification 
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The maximum number of attempts for verification of a SSN is 5.  The SSN field will be locked 
once the verification is sent by SSA. 
 
 
 
 
Section 4 
 

Reading Notes on a Record 

 
Click Actions – Show Notes 

SSN Record Status Values 

WAITING, PASSED, FAILED 
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The Note Present indicator is displayed on 

the bottom of the screen when a note is 

attached to the record. 

Tip: The record 

must be OPEN to 

read the attached 

notes. 
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When multiple notes are on a record, you need to highlight the note you want to read and it will 
display in the box on the bottom half of the screen.  As the number of notes on a record grows, 
you may need to use the scroll bar on the side of the window to get to the note you need to 
read. 
 
 
 
 
 
 

Highlight the note you 

want to read.  It will 

appear in this window. 
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Adding Notes to a Record 

 
Click Actions – Show Notes 

 

While the record 

is OPEN in the 

background, you 

can add the note. 
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IMPORTANT!! YOU MUST SAVE THE RECORD TO SAVE THE NOTE AND COMPLETE THE PROCESS! 
 
Click File – Save 

 
 
 
 
 

After adding your 

note, saving it and 

closing the screen, 

you must SAVE 

YOUR RECORD too! 

Click – New and type your note 

 

Click – Save to save the note 

 

Click – Close to exit the 

window 
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Locating an Existing Record Using the Search Option 

 
Click Search – Death 

 
 
 
Enter First Name, Middle Name, Last Name and click Search 
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Highlight the record – click Display. 

 
 
System will display the record. 
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Creating an Affidavit 

Note: The record must be open prior to starting this process.  To find a record, go to Locating 
an Existing Record Using the Search Option earlier in this section. 
 
From the DISPLAYED death record, click File – New – Affidavit 
 

 
 
Enter the general information on Applicant tab 
 
(this information is usually the funeral director’s name and location) 
  

 
 
 

With the FILED or 

REGISTERED 

record OPEN in the 

background, create 

the Affidavit. 
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Note:  if the decedent’s information is not showing at the bottom of the applicant tab, the 
affidavit has not been correctly accessed and will not link to the death record.  User must access 
File>New>Affidavit from the displayed death record.       
 
 
Enter information “to be corrected” on Corrections tab 
 

 
 
 
Note:  if the item the funeral user is correcting is either not in the dropdown OR displays 
correctly in EDRS but incorrectly on the manual death certificate, the Item to be Corrected can 
be left blank, which will leave the Original Entry blank, and both entries can be manually written 
on the affidavit once it is printed. 
 
The Affidavit of Personal Knowledge section should auto-fill from the Applicant tab.  The only 
field to be filled out here would be the County of field. 
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Enter the Central Office information for the Affidavit 
 
Enter “Y” into Affidavit Info Completed and Signed 
 
This is the only field to be entered here.  If the Record Status is changed manually in any way, 
it will impact the printing of the affidavit and may lead to it needing deactivated.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Date Affirmed/Subscribed 
Leave this date field blank for 

the registrar to input after 

receipt of the notarized 

Affidavit. 
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Click File – Save 
 
The signed date and the Record Status will automatically update. 
 

 
 
 
Click Requests – Print: Affidavit of Death 
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Note:  if user receives the below message, the affidavit was not accessed correctly or was 
changed manually in the Central Office/Record Status field and will need restarted. 
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Printing a Blank Supplemental 
 
The physicians not online with EDRS will be required to submit medical supplements related to 
the death record.  In order to track the medical supplemental form, it must have the case file 
number, also referred to as the ODH number, on it.  To accommodate this requirement, the 
funeral directors and clerks, registrars and clerks and sub-registrars can print a blank medical 
supplement with the key demographic information.  The original record will need to be 
opened and have the filed or registered status in order to print this blank supplemental form. 
 
The record must be in an overall filed or registered status, personal information in complete 
status and the medical information in paper status. 
 
Display the death record and access Requests-Print:Supplemental Blank 
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To print the blank supplemental click the printer icon in the upper left corner. 
 



  
2/9/2017 

 

 

The Ohio Department of Health, Bureau of Vital Statistics 

EDRS guide for Funeral Directors 

last updated:  5/12/2016 

 Page 43 of 64 

Ohio Department of Health 

Bureau of Vital Statistics 

Electronic Death Record System – Funeral Director  

Creating a Certificate of Service 
 
Click – File – New – Certificate of Service 

 
 
 
Enter information for the deceased. 
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Enter “Y” for Complete and Date Completed 

 
 
Click File - Save 

 
 
Click Requests – Print: Death Certificate of Service 
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Handling a Trade Call 
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Section 5 

Viewing Errors on a Record 

The system allows you to address errors individually during the data entry process or through 
the Field Edit Results Display Screen. 
 
With the record OPEN, Click Actions – Review Errors/Queries 

 

 
Note:  Soft Edits: is information entered into a field outside normal acceptable range, but have 
been verified to be correct and have been overridden in the system to complete the record.  
Hard Edits: is information entered into a field that is not acceptable and must be corrected or 
the system will not allow completion.

Tips: 

 Double click on the field name listed as having an 

error to return to make correction. 

 To exit the screen: click the X in upper right 

corner. 
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EDRS Reports 
The system has a Provisional Filed and SSN Not Validated report for you to view or print.  To 
access these reports you will use the Batch menu option. 
 
Select menu options Batch - Reports 

 
 
Click + next to DEATH folder; Click the report you want to view 
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After clicking the report you want to view, click the Preview button 
 

 
 
 
The system will display the report on screen in a ‘print preview’ window. 
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To print the report, click the printer icon in the left upper corner. 
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Section 6 

 
Funeral Home Extract 
 

Extract Administrator – Generating the Extract File 

 
***Please read this section entirely before proceeding with an Extract.*** 
 
As a funeral director extract administrator, you can now extract data from EDRS system to 
import to other systems you may be supporting. This process allows you to extract a file of 
death certificate information and then import the file into your application of choice.  
 
***WARNING! Follow these steps exactly and you will not have to modify the extract 
settings.*** 
 
Follow these guidelines to extract death record information from EDRS. 
 

1) Create a folder on your workstation hard drive.  
 
Note: This spelling must be an exact match or the EDRS extract function will error when 
you try to run it. 

 Open up Windows Explorer. Note: You can also double click on “My Computer” 
and then double click on the (C:) drive to create the new folder. 

 Highlight the Local Disk (C:). 
 Then select “New” and then “Folder” from the explorer menu. 

 

 
 
 

 Name the folder 
 Important: You must remember this name EXACTLY. 
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2) Then login into the EDRS system as a funeral home extract administrator. 
 No one else can run this process. 

 
 
 

3) Select “Batch” and then “Exports” from the application menu bar. 

 
 
Note:  The system will prompt you to select the location (profile) again for the extract 
administrator. 
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4) Once you select the appropriate profile, click “OK” 
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Note: All users will receive this pop-up message, simply click “OK” to close. 
 

 
 
Note: If you have saved previous extracts which display in this listing, you may highlight and 
select them.  However, if a record has been extracted previously and the “perform updates” box 
was checked, it cannot be extracted again.  The “perform updates” box is on the next screen. 

Click “Cancel” to close the 

Select Parameter box.  See Note 

below for explanation 
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This screen has 4 areas of input to be performed in the following order: 
#1 Input the folder names you created on your hard drive.  The names MUST MATCH exactly.  V: 
= C: for users in EDRS, so you MUST use the V: to represent C: in the field. 
 
Note:  If you do not rename your files, the system will AUTOMATICALLY overwrite your files.   
 
#2 For ease of use, leave the Date of Death BEG,END field the ENTIRE YEAR. For example: 
01/01/2007,12/31/2007.   
 
Note: Once the records have been extracted, they cannot be pulled again, therefore the dates 
you have in this field do not make a difference with records getting pulled a second time. 
 
#3 Perform Updates – sets a flag in the system, stating the records have been pulled. 
 
#4 Start Extract - will initiate the pulling of records, which have NOT been previously pulled. 

 
 
 

#

1 

#

2 

#

4 

#

3 
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If you receive the following message after starting the extract, it is because your names do not 
match for the folders.  Click OK and re-key the folder names on the extract screen under step #1. 

 
 
 
Click No in the following window to not save the parameter.   Even though it allows you to save 
the parameters, you cannot extract records more than once.   
 

 
 
 
Note:  The way the extracts are pre-configured, it will automatically select records that have not 
been previously exported.  
 
Tip: You can run this extract without checking the “Perform Updates” box for a test run of the 
extract, but it must be checked to mark the records as extracted so the next time you run the 
extract it will ignore previously downloaded data. 

 When this is “Not” checked, the extract will pull data without updating which 
records were extracted. 

 When this is checked, the extract will pull data and update the record so that 
data is not pulled in subsequent extracts. 

i. This flagging is to PROTECT you from pulling the same record more than 
once. 

 
You will ALWAYS get the NEW and OLD records which have not been FLAGGED as extracted.  

 
 
A progress bar will appear stating “Counting records.” 

 You will see a progress bar that will show you; 
i. Records Processed. 

ii. Records Written. 
iii. Total Number of records. 
iv. Any Errors. 
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Once extract has completed progress bar will state “Processing Completed”. 
 

 
 
Your extract is now completed. Click on the “Completed” button on the extract status bar to 
close this dialog. 
 

Reviewing Your Extract File 

 
This is a good time to review the output files and determine if there are any issues. Go to the 
folder on your hard drive and locate the extract file names you created. Double click on the file 
and review the information. The Error Log file should be blank. The main extract file should 
contain your data. 
 
Note:  The Ohio Department of Health, Office of Vital Statistics HIGHLY RECOMENDS that you 
rename this file, so that the next time you extract information the file isn’t overwritten with new 
data. 
 
 

a. To rename the file, open the folder where the extract is located. 
b. Right click on the file and select rename from the menu. 
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c. The recommended name for the file is “DEATH” followed by the date the extract 
was run and the file extension of “txt”. 

v. Example: DEATH03172006.txt”, indicates that this file was created on 
March 17, 2006. Because this was the date used to extract the 
information, it will match the data that the EDRS system updated the 
records that were pulled from the system. 

 
 
 
***At this time the EDRS application does not support the use of the “Schedule Extract” 
feature.*** 

 

 
 
For the funeral homes requiring extraction of death records filed by their institution, the 
following file layout has been created.   
 

 Records extracted are assigned to the funeral home of the current user logged into 
EDRS. 

 The user has the option to select non extracted or all records based on range of 
dates i.e. begin date and end date. 
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 The funeral home extract administrator and the ODH/VS System/Extract 
Administrator can extract this information. 

 

Serial 
Number Field Name Field length 

Field 
Type 

1 Decedent First Name 50 Varchar 

2 Decedent middle name 80 Varchar 

3 Decedent Last name 50 Varchar 

4 Decedent name suffix 10 Varchar 

5 Alias indicator 1 1 Varchar 

6 Alias Name 1 250 Varchar 

7 Alias indicator 2 1 Varchar 

8 Alias Name 2 250 Varchar 

9 Alias indicator 3 1 Varchar 

10 Alias Name 3 250 Varchar 

11 Sex 1 Varchar 

12 SSN 9 Varchar 

13 Date of Death 10 Date 

14 Date of Death Text 15 Varchar 

15 Date of birth 10 Date 

16 Age 3 Varchar 

17 Age indicator 28 Varchar 

18 Place of death 40 Varchar 

19 Facility name 50 Varchar 

20 Facility City 40 Varchar 

21 Facility county 40 Varchar 

22 Facility state 25 Varchar 

23 Facility zip code 15 Varchar 

24 Armed service 1 Varchar 

25 Disposition name 40 Varchar 

26 Cemetery name 60 Varchar 

27 Cemetery city 45 Varchar 

28 Cemetery state 45 Varchar 

29 Decedent resident address 60 Varchar 

30 Decedent residence number 10 Varchar 

31 In city limits 1 Varchar 
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32 Residence zip code 15 Varchar 

33 Residence city 40 Varchar 

34 Residence county 40 Varchar 

35 Residence state 25 Varchar 

31 Dec resident country 40 Varchar 

32 Birth state 25 Varchar 

33 Birth country 40 Varchar 

34 Marital status 50 Varchar 

35 Spouse first Name 45 Varchar 

36 Spouse middle Name 80 Varchar 

37 Spouse last Name 45 Varchar 

38 Spouse suffix 10 Varchar 

39 Father first Name 45 Varchar 

40 Father middle Name 80 Varchar 

41 Father last Name 45 Varchar 

42 Father suffix 10 Varchar 

43 Mother first Name 45 Varchar 

44 Mother middle Name 80 Varchar 

45 Mother last Name 45 Varchar 

46 Mother suffix 10 Varchar 

47 Informant first Name 45 Varchar 

48 Informant middle Name 80 Varchar 

49 Informant last Name 45 Varchar 

50 Informant Suffix 10 Varchar 

51 Informant related to decedent 40 Varchar 

52 Informant mailing address 60 Varchar 

53 Informant city 40 Varchar 

54 Informant state 40 Varchar 

55 Informant zip code 15 Varchar 

56 Decedent education 50 Varchar 

57 Hispanic origin 1 Varchar 

58 Mexican 1 Varchar 

59 Puerto Rican 1 Varchar 

60 Cuban 1 Varchar 

61 Other 1 Varchar 
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62 Other description 20 Varchar 

63 Race - White 1 Varchar 

64 Race - Black 1 Varchar 

65 Race - American Indian or Alaskan Native 1 Varchar 

66 Race - Native Description 1 30 Varchar 

67 Race - Native Description 2 30 Varchar 

68 Race - Asian Indian 1 Varchar 

69 Race - Chinese 1 Varchar 

70 Race - Filipino 1 Varchar 

71 Race - Japanese 1 Varchar 

72 Race - Korean 1 Varchar 

73 Race - Vietnamese 1 Varchar 

74 Race - Other Asian 1 Varchar 

75 Race - Other Asian Description 1 30 Varchar 

76 Race - Other Asian Description 2 30 Varchar 

77 Race - Native Hawaiian 1 Varchar 

78 Race - Guamanian or Chamorro 1 Varchar 

79 Race -Samoan 1 Varchar 

80 Race - Other Pacific Islander 1 Varchar 

81 Race - Other Pacific Islander Description 1 30 Varchar 

82 Race - Other Pacific Islander Description 2 30 Varchar 

83 Race- Other 1 Varchar 

84 Race - Other Description 1 30 Varchar 

85 Race - Other Description 2 30 Varchar 

86 Race - Unknown 1 Varchar 

87 Race - Not Obtainable 1 Varchar 

88 Race - Refused 1 Varchar 

89 Occupation 60 Varchar 

90 Industry 60 Varchar 

91 Physician assigned 1 Varchar 

92 Physician Name 75 Varchar 

93 Coroner assigned 1 Varchar 

94 Coroner Name 75 Varchar 

95 Funeral Home Identifier 10 Varchar 

96 Funeral director name 75 Varchar 
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Section 7 
 
Tips for Printing from EDRS 
 
If, when trying to print from EDRS, the document sent to the printer does not print, it’s possible 
the user’s EDRS settings are not selected for the printer in question.  To choose the correct 
printer, go first to File>Print Setup: 

   
 
Make sure the correct printer is showing in the printer name field.  If not, select the correct 
printer from the dropdown box and close. 
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After verifying the File>Print Setup  is correct, go to Tools and then Preferences: 
 

 
 
Under Tools>Preferences, make sure that, for each document listed, the correct printer name is 
showing in the Printer field.  If not, utilize the dropdown to choose the correct printer.  Once 
finished, hit Save. 
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In the event the above options do not solve the printing issue, it’s possible the funeral user may 
need to change the Printer Property settings from the Start Menu of their terminal.  To do this, 
access the Control Panel>Devices and Printers: 
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Right click on the default printer and select Printer Properties. 
 
 

 
Access the advanced tab on the Printer Properties, and make sure the checkbox for Enable 
Advanced Printing Features is not checked.  If it is, clear the checkbox and hit OK. 
 

 


